USFS Minimum Protocol for Social Trail Monitoring in Wilderness

Ashley D’Antonio and Troy Hall

Oregon State University

November, 2016
# Table of Contents

1. INTRODUCTION .......................................................................................................................... 4

2. DATA COLLECTION ....................................................................................................................... 4
   a. Standards/Requirements................................................................................................................ 4
   b. Pre-work Procedures to Occur in the Office.................................................................................. 6
   c. Procedures to Occur in the Field................................................................................................... 7
   d. Technical Directions for Data Collection .................................................................................. 15

3. DATA MANAGEMENT & ANALYSIS .............................................................................................. 20
   a. Data Preparation and Processing............................................................................................... 20
   b. Specific Analyses......................................................................................................................... 22
   c. Data Analysis in GIS Environment............................................................................................ 28
   d. Map Making............................................................................................................................... 31
   e. Data Analysis in Table Format .................................................................................................. 32

REFERENCES ...................................................................................................................................... 34

APPENDICES ..................................................................................................................................... 35
   Appendix A. Glossary....................................................................................................................... 36
   Appendix B: Condition Class Rating Examples............................................................................. 37
   Appendix C: Summary of Social Trail Characteristics -- Field Guide ............................................ 43
   Appendix D: Example Data Sheet for Paper Data Collection......................................................... 44
   Appendix E. Frequently Asked Questions..................................................................................... 45
List of Tables

Table 1. Options for collecting data on social trails ..........................................................5
Table 2. Reference table for where to find ArcMap analysis instructions in this report and examples of the analysis output in the pilot study summary report (Kooistra et al., 2016)........................................................................................................34

List of Figures

Figure 1. Decision tree for monitoring social trails and spurs..............................................9
Figure 2. Example Map of Social Trails, Illustrating Segmenting, Spurs, and Conditions ..............................................................................................................................13
Figure 3. Example of data entry in Excel for paper data collection. .................................19
Figure 4. Screenshot of DNR GPS with social trail spurs (waypoints) and social trails (tracks) loaded from a GPX file. .................................................................22
Figure 5. Screenshot of Split tool with dialog box completed............................................23
Figure 6. Example of Join dialog box from ArcMap............................................................25
Figure 7. Example of how to complete the Select by Location dialog box .......................27
Figure 8. Screenshot of symbology tab displaying social trails by condition class..............29
Figure 9. How line density is calculated in ArcMap in the “Line Density” tool.................31
Figure 10. Attribute table with “Table Options” icon opened. ............................................33

Suggested Citation for this Protocol


Cover photos by Chad Kooistra
1. INTRODUCTION

This protocol is intended to serve as the national minimum protocol for monitoring social trails (also called “user trails”) in Forest Service wildernesses. Most social trails are non-system, informal, trails created by trampling that were not installed and/or are not maintained by managers. (However, in this protocol, abandoned system trail segments that are still receiving recreational use will be considered social trails.) Social trails are inclusive of all types of user trails, from short segments between campsites to longer cross-country routes.

Monitoring social trails can be useful to wilderness managers for various reasons. For immediate management decisions, an inventory can provide a comprehensive picture of where problems exist. This can be useful for project planning and to support decisions about appropriate management actions. Monitoring is also useful for long-term management, to indicate how conditions are improving or degrading over time. Such information is important for monitoring wilderness character. When the intent is to use data for long-term monitoring of change, it is critically important that consistent decision rules (e.g., what counts as a social trail? What areas are monitored?) are followed across observers and over time.

Implementing this protocol will allow wildernesses to score points in annual Wilderness Stewardship Reporting under the “Trails” element. The intent of this protocol is to inventory and assess the majority of social trails within a wilderness. The protocol does not require assessing 100% of all social trails, because it is recognized that some trails may occur in remote areas that receive little use, and the effort required to inventory those trails would be prohibitive. As noted in the Wilderness Stewardship Performance guidebook, to score 2 points under the Trails Element, “A documented protocol has been used to survey user developed trails in all ‘priority areas’ in this wilderness. Priority areas are locally-determined and should include a wide spectrum of areas, from high-use destinations to low-use backcountry.” This national minimum protocol fulfills these requirements, and it provides guidance on identifying priority areas.

This is a minimum protocol designed to be applicable across all units of the NWPS. If local units have a protocol that is at least as comprehensive as this protocol, they may use that existing protocol to claim points in Wilderness Stewardship Performance. Local units may also choose to customize (add to) this protocol to include locally important data (e.g., information on whether social trails are used by stock vs. hikers).

2. DATA COLLECTION

a. Standards/Requirements

This protocol can be implemented using various types and levels of technology, but some form of GPS device is required to map social trails (Table 1). There are two key components to the protocol:

- First, the geographic length of each social trail and the location of each social trail spur must be recorded.

---

1 Terms in bold italicized text are included in the Glossary in Appendix A.
- Second, selected characteristics about the level of impact of the social trail (width, condition class, and presence of human waste) must also be documented and associated with the geospatial data on the extent of the trail for later analysis.
- An optional, third component is identifying the primary use for the social trail. If the primary use of the social trail can be confidently identified (e.g., hunting, climbing access, viewpoint, etc.) this activity can and should be documented in the data sheets/data dictionaries. If the primary use cannot be identified, the social trail can be labeled as “general visitor use” and other information can be entered in the comments sections during data collection to provide context for the social trail.

GPS-based devices make mapping the extent of a social trail very quick and easy. Lower cost and less accurate recreation-grade GPS units, like handheld Garmin units or similar devices, can be used to map the length and location of the social trails and the location of social trail spurs, but information on trail impact characteristics will need to be recorded on a separate, paper data sheet and entered manually into a spreadsheet. The GPS data from recreational, handheld units will have to be later cross-referenced with the data on trail impact characteristics for analysis and reporting.

Mapping-grade GPS units, like those made by Trimble, are more accurate in their mapping capabilities but also more expensive and slightly harder to learn to use. The benefit of many mapping-grade GPS units is that they often contain applications that allow for data collection of trail characteristics within the program. Therefore, the characteristics data are automatically linked to the spatial data (location and length) of the social trail. This makes post-processing of the data much easier and does not require any data entry after field protocols are completed.

Finally, smart phone and tablet applications, such as Collector by ESRI, can be an alternative to stand-alone GPS units. Smart phones and tablets have built-in GPS capabilities, and mapping apps provide the same ability to enter characteristics data that are automatically attached to the spatial data of the social trails. The GPS units in smart phones and tablets are less accurate than mapping-grade GPS units but are generally easier to use and less expensive.

Table 1. Options for collecting data on social trails

<table>
<thead>
<tr>
<th>Trail length</th>
<th>Condition data</th>
<th>Linking data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recreation-grade GPS^</td>
<td>GPS unit</td>
<td>Paper/tablet</td>
</tr>
<tr>
<td>Mapping-grade GPS*^</td>
<td>GPS unit</td>
<td>Data logger</td>
</tr>
<tr>
<td>Smart Phone or Tablet and Collector App*^</td>
<td>GIS Interface App</td>
<td>Data logger</td>
</tr>
</tbody>
</table>

^For all GPS-based data collection, use datum WGS84
*A pre-written data dictionary will be provided for use with Trimble brand GPS units (GeoXT, Juno, etc.) and the software program TerraSync. The data dictionaries will be located on an internal USFS SharePoint site. Contact your Regional Program Manager for further
information. Additionally, ArcPad and the Collector app will have pre-made interfaces for this protocol.

b. Pre-work Procedures to Occur in the Office

Determine the Inventory Area. Before field data collection, staff should review maps and local knowledge of attraction sites to identify locations where approximately 90% of social trails are expected to occur. It is also helpful to review what data have been collected in the past related to social trails, current system-trail inventories, and campsite assessments (e.g., data collected with the minimum protocol for recreation site inventories). These data can help identify which areas should be searched for social trails. Carefully document any decisions about areas that will not be inventoried. For instance, you might decide not to monitor areas in steep, inaccessible terrain where you know use is low, or you may intentionally exclude abandoned system trails that are still evident in the landscape but no longer in use.

Create a Trail Naming Convention. If you are using a recreation-grade GPS and recording social trail attributes on paper, choosing a clear and meaningful naming convention will be critical for ensuring consistency across different personnel and matching characteristics to the spatial data. This should be clearly documented before fieldwork begins. Do not use spaces in your naming if at all possible; instead use underscores in place of spaces when naming trails (e.g., 3456_01 vs 3456 01). One option is to begin the name with the nearest USFS system trail number, then provide each data collector with a unique sequence of numbers. For example, when monitoring social trails near Trail #1090, one ranger could begin naming trails as such: 1090_100, 1090_101, 1090_102…; another ranger monitoring social trails in the same area could use this sequence: 1090_200, 1090_201, 1090_202…); a third ranger could use this sequence: 1090_300; 1090_301, 1090_302…), and so on. Managers may change the GPS file names after all of the data have been collected for that particular area to a slightly simpler format if desired (e.g., 1090_01, 1090_02, 1090_03…), as long as they also change the name of the trail in the spreadsheet or add another field with the new name so that the GPS files and datasheet information line up correctly for analysis and mapping purposes.

Choose the Appropriate Technology. All technological options should be considered and weighed. Some things to consider are the following:

- Technology type available
- The number of people who will be collecting data at one time (which affects number of units needed)
- Skills of individuals collecting data
- Battery life needed during data collection
- The need to collect other data (e.g., on campsite conditions) simultaneously

When using GPS-based methods of data collection, before heading into the field, load any basemaps that may be helpful in locating social trails and review what data have already been collected. Some examples of useful basemaps include (but are not limited to) the following:

- Administrative boundaries
• Roads
• System trails
• Social trails that have previously been mapped
• Water layers with the locations of lakes and rivers
• Topographic maps
• Campsite monitoring maps

When choosing which and how many basemaps to include, be conscious of the memory space available on devices. You may want to print a hardcopy of maps with all layers, but only download selected layers to the device. In addition to preparing basemaps and loading these onto the GPS-based device, be sure that all technology is fully charged prior to heading into the field for data collection. Prepare and pack extra batteries or other means of charging the batteries of your devices (such as portable solar panels or a portable, external battery charger – sometimes called lipstick chargers).

It may be helpful to print out maps or Google Earth images for the locations that will be monitored. If you will be recording data on paper, be sure that you have an adequate number of data sheets and writing utensils.

Train Data Collectors. Being able to consistently and accurately describe the condition of trails takes practice. It is important that training occur so that all data collectors are familiar with the protocol and make the same determinations about what constitutes a social trail or spur, the condition of a trail, and the width of a trail. This training can take place in any front-country location where there are social trails.

c. Procedures to Occur in the Field

Locations searched for social trails should be carefully mapped to ensure that future monitoring can be done within the same locations.

Likely locations for social trails include the following:

• Areas near trailheads where there may be “toilet” trails or shortcuts from parking areas to system trails
• Trail junctions
• Water bodies near a system trail (generally within ¼ mile of the trail in forested environments) or that are visible from a system trail
• Access to climbing routes
• Scenic viewpoints
• Places where off-trail travel is facilitated by topography and vegetation (e.g., subalpine areas with open views)
• Camping areas
• Features named on wilderness maps
• Abandoned system trails, if they are actively being used by visitors
• Known illegal structures (e.g., hunting camps)
• Approved non-compliant structures and historic structures/features of interest (e.g., lookouts, cabins)
• Inholdings or active mining claims
• Areas adjacent to high use locations outside wilderness that don’t have trailhead facilities or designated trails (e.g., youth camps, private residences)
• River corridors where access is by boat
• Hunting areas

When searching an area for social trails, the following process should be used:

• Within the search area, walk the length of all system trails, looking carefully for social trails.
• In areas with dense networks of social trails, it will be helpful to scope the area out to understand where the different segments and spurs are, so you can have a plan for monitoring all of them. (See “special considerations – networks of trails.”)
• At lakes, travel around the shoreline to the extent possible given vegetation and topography. (Be sure to note what section of shoreline were and were not searched.)
• Where lakes are relatively near each other, explore for user trails connecting one lake to another.
• In locations where trails are close to lakes, look for user trails providing short-cuts to water access.
• In areas with resistant or resilient meadow vegetation, look for user trails where the meadow and forest meet.

Spatial Mapping of Social Trails

Once a social trail has been located, determine if the segment is at least 30 feet in length — this will determine whether to map it as a trail or as a spur (see Figure 1). For trails, the lineal extent will be mapped using a GPS unit or GPS-enabled phone or tablet. Starting at the location where the social trail intersects with an organizing feature (designated system trail, another social trail, campsite, etc.), record a few (2-3) points to mark the start of the trail accurately. Then, while recording with the GPS unit or GPS-enabled phone or tablet, walk the extent of the social trail (at an average hiking pace) to its completion. If the trail takes any sharp curves, be sure to pause at these changes in direction to ensure accurate mapping. Once you reach the end of the social trail, record a few points (2-3) with the GPS or GPS-enabled phone or tablet unit to ensure the end-point of the social trail is recorded accurately. For trail spurs, the only GPS data that will be recorded are the points where the spur leaves an organizing feature.
Figure 1. Decision tree for monitoring social trails and spurs

Is the trail > 30 feet in length?

No

Map as a “Spur”

Record Trail Width, Condition Class, Presence of Human Waste,

Yes

Map as a “Trail”

Is the trail 30 - 60 feet in length?

Map entire trail length as a single segment

Is the trail > 60 feet in length?

Watch for changes in level of impact as you walk the trail

If width or condition class changes and remains consistent for at least 60 feet, map a new segment. Otherwise, map as one continuous segment

For each segment: Record Trail Width, Condition Class, Presence of Human Waste
Assess the Level of Impact

While hiking the social trail – or visually scanning trail spurs -- note all instances of human waste (such as the presence of toilet paper) that are observed while mapping the extent of the trail. Also make note of the level of impact in preparation for assigning impact categories and ratings to the social trail or spur. Specifically, make mental note of the average level of vegetation loss and mineral soil exposure/erosion in the social trail tread, as well as the width of the trail or spur. The start of a social trail or social trail spur may be wider or have more soil impact than the rest of that social trail or spur. Be sure to scope the social trail or social trail spur without mapping for a few feet before thinking about assigning a width category or condition class rating so that you are not unduly biased by what you see at the beginning of the trail or spur. For social trails, you should wait to assign impact characteristics until after you have mapped the length of the trail and observed the level of impact for the entire extent of the social trail. Although conditions and widths will almost always vary somewhat within a trail, you will assign the condition class and width categories that are most typical of that segment or spur (the average width or condition class). If a social trail’s condition or width class changes and remains different for at least 60 feet, then this will be recorded as a new trail segment. (See Figure 2 for a hypothetical illustration.)

The observations related to impacts to vegetation and soil should be made in relation to nearby, undisturbed locations. In other words, consider how much vegetation loss and soil impact there is on the social trail/spur when compared to nearby areas that visitors do not use.

Once the lineal extent of the trail has been mapped, then the level of impact to the social trail will be recorded. Each trail/spur will be assigned a specific category for each type of impact – when assigning the categories of trail width and condition class consider the average impact to the entire social trail that was just mapped.

(1) Assign the average trail width of the social trail/spur into one of three categories:

- Category 1: < 12 inches in width
- Category 2: 12 inches – 24 inches in width
- Category 3: > 24 inches in width

(2) Assign the social trail/spur to one of three average condition class ratings as described below (See Appendix B for photographs illustrating condition classes). When assigning condition class ratings, be sure to compare social trail/spur conditions to the surrounding vegetation community and soil type. These condition classes are meant to document the level of change from undisturbed conditions. Some ecological communities may naturally be sparse in terms of vegetation. Higher condition class values represent an increasing level of disturbance to the natural community (1 = very little disturbance to 3 = highly disturbed).
It can be difficult to assign condition classes in areas with naturally little vegetation. Therefore, this protocol provides different guidelines for areas with \( \geq 10\% \) vegetation in the surrounding area and areas with 1-10\% vegetation. Condition Class Rating for trails and spurs in areas with at least 10\% vegetation cover should follow these rules:

- **Class 1:** Slight loss of vegetation relative to undisturbed adjacent areas; no soil disturbance or erosion. Lowest level of ecological impact for this ecosystem.
- **Class 2:** Significant vegetation loss compared to undisturbed adjacent areas, but some vegetation remaining in tread; no soil disturbance or erosion. Moderate amount of ecological impact for this ecosystem.
- **Class 3:** Complete loss of vegetation compared to surroundings, and/or soil disturbance or erosion obvious and significant. Highest amount of ecological impact for this ecosystem.

In areas with 1-10\% surrounding vegetation cover, trails/spurs should be assigned Class 1 for minimal soil disturbance and Class 2 for moderate to significant soil disturbance/erosion. Class 3 is not appropriate in these areas, because of the lack of vegetation during undisturbed conditions. Also, in these areas, enter 'B' for barren in the comments (such as a cinder cone or sandy trail) and “A” for alpine areas.

(3) Assign the social trail to one of four categories of human waste presence.

- **Category 0:** No human waste or toilet paper observed
- **Category 1:** 1 instance of human waste/toilet paper observed
- **Category 2:** 2 – 3 instances of human waste/toilet paper observed
- **Category 3:** >3 instances of human waste/toilet paper observed.

(4) Optional, but recommended: If a primary use of the social trail can be determined, that information can be recorded under the comments section of the data sheet or data dictionary. Examples of specific types of use that might be assigned to a social trail/spur include, but are not limited to the following:

- Stock use
- Fishing
- Hunting
- Geocaching
- Climbing access
- Viewpoint access
- Camping access
- Toilet use
- Accessing water
(5) Use the “Comments” section to provide any additional detail that may be useful to managers or may provide context about the social trail. If you are unsure if the information might be useful, record it anyway. Examples of things that might be important to note in the comments include (but are not limited to):

- If visitors are actively maintaining the social trail
- If the social trail leads to known cultural or historical resources
- If built structures are found on or near the social trail
- If the trail is an abandoned/decommissioned system trail that is still receiving use
- If there are special considerations about the environment, such as barren area or alpine environment

See Appendix C for a pocket-sized field card that can be printed and used for quick reference for the category descriptions for the level of impact characteristics.
Figure 2. Example Map of Social Trails, Illustrating Segmenting, Spurs, and Conditions

- **Condition Class 1**: Slight loss of vegetation relative to undisturbed adjacent areas, no soil disturbance or erosion. Lowest level of ecological impact for this ecosystem.
- **Condition Class 2**: Significant vegetation loss compared to undisturbed adjacent areas, no soil disturbance or erosion. Moderate amount of ecological impact for this ecosystem.
- **Condition Class 3**: Complete loss of vegetation compared to surroundings, soil

- **Width Category 1**: < 12 inches
- **Width Category 2**: 12 inches – 24 inches
- **Width Category 3**: > 24 inches
Situations with Special Considerations

**Long social trails with varying conditions.** There is no maximum length for a social trail – some social trails may be extremely long, such as those circling a lake or following the path of a river. Often, a single social trail may change drastically in terms of the level of impact to the trail from visitor use. For instance, vegetation loss may be much higher where a trail is within a forest than where it crosses a meadow. When this happens, a single trail should be mapped as multiple segments. Specifically, if the width or condition of the trail changes from one class to another and remains in that new width or condition class for more than 60 feet, then a new segment of trail should be mapped (see Figure 1 and Figure 2). To do this, stop at the point where impact changes from one category to another and map a few (2-3) points where those conditions end. This will be the end of the social trail segment. Record the average width category, condition class rating, and instances of human waste for that social trail segment. Then, start mapping the lineal extent of a new social trail segment at the same location where you ended the previous trail segment. Continue by following the protocol outlined above.

**Social trail networks where multiple social trails and spurs emanate from each other.** It is often efficient to begin by mapping the main social trail that appears to have the highest level of impact. (Map this social trail in segments, as appropriate, if its width or condition class changes, per guidelines above.) Then, re-walk the social trail that was just mapped, mapping and assessing each social trail and spur that originates off of this main social trail. This type of situation may be common around lakes, along rivers, at campsite clusters, and at viewpoints.

**Very short (<30 feet) social trails.** These social trail “spurs” should be mapped as points instead of linear features. A waypoint can be recorded with the GPS unit or GPS-enabled phone or tablet at the location where the trail intersects with the designated trail, another social trail, or campsite. Information about the level of impact will still be recorded (average width category, condition class rating, and instances of human waste) for the social trail spur as described in the Assessment of Level of Impact section.

**Re-routes of system trails and abandoned trails.** In many wildernesses, historic trails ran directly through meadows or up slopes. Where trails have been re-routed, the original trail tread may still be in use. Where this is the case, the abandoned trails should be inventoried as long as there are signs of active use by visitors. Abandoned trails that are no longer used by visitors are not required to be mapped and assessed as part of this protocol. (However, if a local unit decides to monitor such trails, they may do so.)

**Social trails within campsites or campsite clusters.** Campsites typically have social trails or spurs linking them to system trails, access to water, or other campsites. These trails should be inventoried under this protocol. However, short social trails within a single campsite (e.g., connecting a tent pad to the fire area) should not be inventoried (those impacts should be captured under the recreation site inventory for the wilderness).

**Game trails.** Game trails can sometimes be confused with social trails. Game trails should not be inventoried, unless it is clear that they are being used by recreational visitors. Social trails generally head towards a destination, following topography, and go through vegetation that is
easy for human travel. Game trails may meander or be found on steep grades; watch for signs of wildlife such as wildlife prints or scat that may indicate a game trail.

Unsafe trails. Occasionally you may come across a social trail that is too steep, too eroded, or too close to the edge of a cliff or waterbody to map safely. In such cases, use your best judgment to keep you and your group safe. If you deem that it too dangerous to map a social trail, mark the location where the social trail starts, following the procedures for mapping a social trail spur. In the comments section, make note of why you were unable to map the social trail.

Social trails in restricted areas. Social trails are sometimes closed off for safety reasons or for restoration. If closing of the trails has worked to prevent visitors from using the social trail, this protocol does not require mapping the social trail. However, some units may wish to include such trails in their monitoring, and that decision must be made locally.

Braided trails or switchback cuts. Braided trails or switchback cuts associated with system trails are NOT monitored under this protocol. Those segments are not user trails accessing a destination, and they are more appropriately considered management issues with the system trail. Such impacts should be captured through a system trail condition inventory.

d. Technical Directions for Data Collection

Data Collection

Recreation-grade GPS unit (e.g., Garmin) & Paper Data Collection:

Depending on the brand and model of the recreation-grade GPS unit, the specifics of how to record a track or waypoint vary. Please refer to the user guide of your specific recreation-grade GPS unit to determine how to record a trail and how to mark a waypoint before beginning the monitoring protocol. The steps listed below are meant to be general guidelines.

NOTE: when using a Garmin, once you start recording a trail segment you must complete that track; there is no ability to “pause” like there is with other technology. Therefore, it may be useful to explore an area and develop a plan before beginning to collect data. If you are recording a social trail and uncertain about where it goes or whether the condition class or width change, you can set the unit on the ground (it will keep collecting waypoints) while you explore.

Once a social trail or social trail spur has been located:

(1) Clear any data that may have been recorded while locating the social trail.

(2) Walk the length of the trail or trail segment with the GPS unit and save the track, giving it a Unique Trail ID. If it is a social trail spur (<30 feet in length), create a new waypoint and give it a Unique Trail ID.

(3) Write the Unique Trail ID on the data sheet provided in Appendix D (be sure this ID matches the ID you have given the track or waypoint).
(4) Continue to fill in the remaining columns according to the “Procedures” section of the protocol (above).

Repeat from step 1 for all new social trails/spurs or for new segments of longer social trails.

All of the Garmin Manuals can be found here (find the one for the style of unit used):
https://support.garmin.com/support/manuals/searchManuals.faces

Note: Using a consistent naming convention is extremely important to enable pairing spatial data from the recreation-grade GPS units with the data collected on the paper data sheets. Be sure that a consistent naming convention is used and that the name given to the track or way point perfectly matches the name on the data sheet (and also the name entered in Excel during data entry). Names must match in all aspects, including use of upper/lower case, spaces, and symbols.

Mapping-Grade GPS Units (E.g., Trimble GeoXT or Juno) and TerraSync Data Collection:

At the beginning of data collection:

1. Open TerraSync (or alternative mapping software pre-loaded onto the GPS unit)
2. Create a new data file and enter a unique name (E.g., monitoringsite_date).
3. Select the “SocTrailMonitor” data dictionary

Once a social trail or social trail spur has been located:

1. Select the “Social Trail” button when mapping a social trail (this will map as a linear feature). Select “Spur” when mapping a social trail spur (will map as a point feature).
2. Follow the “Procedures” section to map the linear extent of the social trail or mark a spur as a waypoint.
3. After mapping the location of the social trail, fill in the data dictionary using the drop-down menus or fill-in data where appropriate. Refer to the “Procedures” section for a description of the categories for each attribute in the data dictionary.
4. Close the feature when the data dictionary has been completely filled out.

Mapping-Grade GPS Unit (Trimble Juno 3b) and ArcPad data collection:

At the beginning of data collection, in the office:

1. Copy the ArcPadDataCollectionFolder to your project or forest workspace.
(2) Open the map document (.mxd) and use the S1 Data Manager to check out data to ArcPad. This is the map document that you will use for subsequent check out/check in processes.

(3) On the device, open the ArcPad map document (.apm) that you checked out.

Once a social trail or social trail spur has been located:

(1) Tap on the Create Line feature and select “social trail” if you’re mapping a trail. Tap Create Point Feature and select “spur” if you’re mapping a social trail spur.

(2) After collecting the feature geometry, enter the attributes for the feature. Use the drop-down menus or fill in data where appropriate. Refer to the “Procedures” section of the protocol for an explanation of these attribute fields.

(3) Tap OK to save your feature and return to the map.

The ArcPad help website can be found here:

http://resources.arcgis.com/en/help/arcpad/10.2/app/index.html#/Welcome_to_the_ArcPad_help_library/00s1000000t8000000/

Collector App for Smart Phones and Tablets:

At the beginning of data collection while connected to Wi-Fi (otherwise the data will not be download and saved):

(1) Open the “Collector” app on your smart phone or tablet.

(2) Sign into the USDA Forest Service organizational account using your username and password. (When you open the app, it will prompt you to sign in with your own login credentials, which will be linked to the USDA FS account automatically.)

(3) Download the features and basemap for your project area.

(4) Open Social Trail map.

(5) You may be prompted to “Choose Your Work Area.” If so, zoom in as closely as possible to the area you will be in when collecting social trail data. Add any additional basemaps that may be useful, using the “More” button.

(6) While still in the office, click the Collect New button (may appear as a “+” sign). Select “Social Trail” but do not begin collecting data. Instead, open the Settings button (which may appear as a gear). Slide “Required Accuracy” to 10m. Click Save.
Once a social trail or a social trail spur has been located:

(1) While standing at the start of the social trail or the social trail spur, tap the “Collect New” button in the Social Trail Monitoring map.

(2a) Select the “Social Trail” button when mapping a social trail and move onto step 3. If you have located a social trail spur, use step 2b.

(2b) Select “Spur” when mapping a social trail spur. Data will begin collecting automatically for a social trail spur. So once you click “Spur” you can immediately begin entering the characteristic data (condition class, width, human waste, and activity type) by moving on to Step 4.

(3) Follow the “Procedures” section to map the linear extent of the social trail.

(4) After mapping the location of the social trail or social trail spur, fill in the attribute table associated with the feature you just mapped. Refer to the “Procedures” section for a description of the categories for each attribute in the data dictionary.

(5) Tap “Done” when you have completed mapping the social trail and entering the attribute data.


**After Data Collection:**

**Recreation-grade GPS unit (e.g., Garmin) & Paper Data Collection:**

Upon return to the office:

(1) Manually enter the data from paper data sheets into Excel using the same headings as the column names on the data sheets. See Figure 3 for an example of how data should be entered.

(2) Once data have been entered, file the data sheets into a safe location in case they need to be cross-referenced at a later time.

(3) Using the software program provided by the GPS manufacturer or [DNR GPS](http://doc.arcgis.com/en/collector/), download the social trail tracks and social trail spur waypoints from the GPS unit.
Figure 3. Example of data entry in Excel for paper data collection. The comments section can contain other information that managers may find useful.

Mapping-Grade GPS Units (E.g., Trimble GeoXT or Juno) and TerraSync Data Collection:
Upon return to the office:
(1) Use TerraSync to import the social trails and social trail spurs into PathFinder Office.
(2) Export the data as Shapefiles using the appropriate datum and projection.
(3) Open in ArcMap and define the datum and projection in preparation for data analysis.

Mapping-Grade GPS Unit (Trimble Juno 3b) and ArcPad data collection:
Upon return to the office:
(1) In ArcMap, use the same map document to check in your data, using the S1 Data Manager.
(2) Create a new checkout for use on your next data collection effort.

**Collector App for Smart Phones and Tablets:**

Upon return to office:

**Ensure you have Wi-Fi access in order for data to upload**

(1) Open Collector App.

(2) In the “My Maps” menu on the “Social Trail” map, click on the cloud icon to sync your data.

Be sure to back up all data in multiple locations (including the O drive) and maintain any paper-based data sheets.

Before heading back into the field for additional data collection, clear previous data from the devices (Juno, Collector App, Garmin, etc.). You may want to upload the social trails layer collected during previous monitoring efforts as a base layer on these devices to prevent remapping of any social trails. The social trails layer should show you which social trails were mapped during previous data collection efforts that season.

It is recommended that spatial data be examined for quality control and quality assurance regularly during the data collection season. It is not advisable to wait to look at the data in GIS at the completion of data collection. For quality control and quality assurance, data can be examined in Google Earth if there is no access to ArcMap during data collection.

This website explains how to upload GPS data to Google Earth:
https://support.google.com/earth/answer/148095?hl=en

3. DATA MANAGEMENT & ANALYSIS

a. Data Preparation and Processing

These steps should be followed to bring the data files (line features for social trails and point features for spurs) into a GIS environment as shapefiles for analysis. **ALWAYS make a back-up copy of the social trails shapefiles before beginning any analysis** – you should always do your analysis on a copy of the original shapefile in case errors are made or data are lost.

Before any analysis is completed, it is recommended that data be brought into GIS and examined for quality control and quality assurance. After importing the shapefiles into ArcMap (instructions below), be sure to examine the data for duplicate social trails or spurs. If duplicates or significant errors (such as mistakenly mapping a large part of a system trail or forgetting to stop data collection after mapping a social trail and mapping while you are searching for other
trails) are found in the shapefiles you can delete these features or edit them. If you are not familiar with these techniques in ArcGIS, consult with a GIS specialist.

Extra steps are required for data collected with a recreation-grade GPS unit and associated paper records of characteristics. For all other data collection techniques, the data files should already be in shapefile format and no additional steps will be needed. The data files can simply be opened directly into ArcMap following step 4 below. If the data do not display correctly, make sure that the shapefile has the correct projection. This blog post can help with projection issues.

Recreation-grade GPS unit (i.e. Garmin) & Paper Data Collection:

(1) Using DNR GPS, or a similar program, open the trails and waypoint files (for spurs); the files will be in GPX format (Figure 4). You can do this by clicking on “File” → “Load From” → “File.”

(2) Set the appropriate projection for the data you have collected. Export the data as an ESRI Shapefile. To do this click “File” → “Set Projection” → Datum = WGS 84 → Select the correct UTM zone for your region. If you do not know the UTM zone for your area, use this map for the contiguous United States (click on your location and the UTM zone shows up on the left) and this map for Alaska zones. All UTM zones in the U.S. are northern (N).

Social trails (which would have been saved as “Tracks” by the GPS) and social trail spurs (which would have been saved as “Waypoints” by the GPS) will need to be converted separately:

(3a) To convert the spurs to a point shapefile, select the “Waypoints” tab then click “File” → “Save To” → “ArcMap” → “File.” Give the file a unique file name (Note: do not use spaces in the file name. Suggested format for the file name: area_date_spurs), and be sure the file format is “ESRI Shapefile (2D).

(3b) To convert the social trails to a polyline shapefile, select the “Tracks” tab then click “File” → “Save To” → “ArcMap” → “File.” Give the file a unique file name (Note: do not use spaces in the file name. Suggested format for the file name: area_date_trails), and be sure the file format is “ESRI Shapefile (2D).

Now that both the social trails (now polylines) and spurs (points) have been converted, these shapefiles can be opened in ArcMap:

For all data collection methods:

(4) Open the file in ArcMap using the “Add Data” tool or by going to “File” → “Add Data” → “Add Data.”

(5) You may add additional base layers in ArcMap that might be helpful for providing context for your data. Examples of possible base layers include satellite imagery, topography, roads, trails, wilderness boundaries, or water features (“Add Data” → “Add Basemaps”). Many of these layers can be added via ArcGIS Online (“Add Data” → “Add Data from ArcGIS Online”). Additional layers may be available via USFS GIS specialists.
The following steps can be completed only after the data have been converted to shapefiles and successfully opened in ArcMap.

*b. Specific Analyses*

Selecting Portions of Social Trails within Wilderness Boundaries (Using the Split Function):

Occasionally, social trails may be mapped that extend beyond the boundary of the wilderness. This is perfectly acceptable during data collection since it provides context and information on where social trails enter the wilderness, and it may not be known in the field exactly where the wilderness boundary is located. However, these sections of trail should not be included in summaries of trail length or condition. The following steps describe how to create a shapefile that only includes social trails that are within the wilderness boundary. This shapefile should be used for all length calculations (see “Calculating Length for Social Trails” in the following section). The original shapefile, showing social trails extending beyond the boundary, may be
used in maps for illustrative purposes. However, it should be made clear in reports that only social trails within wilderness were used for calculations of length.

(1) Open the Search box in ArcMap and search for “Split.” Then select “Split (Analysis)” to open the Split tool.

(2) In “Input Features” select the shapefile that contains the social trails that need to be cut at the wilderness boundary.

(3) In “Split Features” select the wilderness boundary that you want to contain the social trails. You can download shapefiles for individual wilderness area boundaries [here](#).

(4) In “Split Field” select the name of the wilderness boundary (see Figure 5).

(5) In “Target Workspace” browse to the folder where you would like the split shapefile to be saved. Click “OK.”

(6) Now add the new split shapefile to the map document by using the “Add Data” tool or by going to “File” → “Add Data” → “Add Data.” Navigate to the folder where you saved the shapefile. You will use this split shapefile in all subsequent steps of the procedures listed here.

This help page provides more information on the Split tool.

**Note:** If there are only a few social trails that extend beyond the wilderness boundary, it may be more efficient to measure the lengths of these sections of social trail using the “Measure Tool” in ArcMap and subtract the lengths of these social trails from the exported Excel file (see “Exporting Attribute Tables from GIS Environment”).

**Figure 5.** Screenshot of Split tool with dialog box completed.
Joining “Paper Data” with GIS Layers for Recreation-grade GPS Data Collection:

The data collected with recreation-grade GPS units will be displayed correctly in ArcGIS but none of the social trail impact characteristics will be in the attribute table. To create maps showing condition class or other characteristics, the data collected on paper must be joined to the shapefile in GIS. These steps are not required for data collected with mapping-grade GPS units or with the Collector mobile app.

1. Ensure that the ID field in the Excel spreadsheet where you entered the social trail impact characteristics data matches the ID field in the shapefile attribute table exactly (you can check this by right-clicking on the shapefile → “Open Attribute Table”). Note that joins are case sensitive so please be sure that the letter cases match, as do any spaces or underscores in the name.

2. Once you have confirmed the ID columns match perfectly (this is essential for the join to work) you will need to convert the social trails impact characteristic Excel file to .CSV format (In Excel: “File” → “Save As” → browse to where you want to save the file → select “CSV” (comma delimited) as the “Save as type” → Name the file appropriately → “Save.”

3. In ArcMap, right-click on the shapefile to which you want to join the social trails impact characteristics → “Joins and Relates” → “Joins.” This should open up a dialog box (Figure 6).

4. In the dialog box, make sure the top drop-down menu says “Join attributes from a table.” In box 1 choose the field in the shapefile that has the ID. In box 2 browse to the CSV file that contains the ID and the social trail impact characteristics that you created in step 2. In box 3 choose the heading of the column that contains the ID (this ID should match the IDs referenced in box 1). Choose “Keep All Records” (this will help identify locations where the join may not have worked). Click “Validate Join.” This dialog box will produce warnings if the join does not work. Click “OK.”
(5) If the join worked, when you open the attribute data for that shapefile (see step 1), if you scroll over to the last column of the table, you should see that the social trail impact characteristics have been added to the shapefile attribute table. You can now create symbology in ArcGIS based on characteristics like condition class (see instructions for that below).

This page is a helpful resource for doing joins in ArcGIS; use this reference if the join did not work properly. Failed joins are usually due to IDs not matching perfectly.
Selecting a Subset of Social Trails or Social Trail Spurs for Analysis

It may be useful to examine a specific site within a wilderness area – such as a lake or a climbing area – and summarize the lengths and impact characteristics of the social trails found just within that area. Data collection may also occur in multiple wilderness areas during the same data collection period and a single shapefile may contain social trails from multiple wilderness areas. If a subset of the social trail shapefile is needed for analysis, the following steps can be used to separate social trail shapefiles. However, you may find it unnecessary to separate shapefiles; this will depend on how the data were collected and how you would like to summarize the length and impact characteristics of the social trails data.

Option 1: Select by Location (used for selecting social trails that can be found within a pre-existing polygon in an ArcMap layer – such as a wilderness area boundary)

(1) Click “Selection” in the top menu in ArcMap → “Select by Location” → Ensure the “Selection Method” is “select features from” → check the box next to the shapefile that contains the social trails you are interested in analyzing.

(2) Set “Source Layer” to the polygon that contains the social trails of interest (this could be a wilderness boundary area).

(3) For the “Spatial selection method for target layer feature” select “intersect the source layer feature.” Click “OK.” See Figure 7 for an example.

(4) Visually confirm, by looking at the selected data, that the Select by Location process worked and then export the selected features from the shapefile using the following step.

(5) Right click on the shapefile that contains the selected social trails → “Create Layer from Selected Features.” This will create a new layer in ArcMap. You can save and export this layer by right clicking on this new layer → Export and using the Export dialog box to save the layer as a shapefile.

(6) Add this new shapefile to the map document by going to “File” → “Add Data” → “Add Data.” Navigate to the folder where you saved the shapefile.

This link is helpful for using the Select by Location feature in ArcMap and contains graphical examples of the different selection methods.
**Figure 7.** Example of how to complete the Select by Location dialog box

**Option 2:** Select Area for Analysis Interactively (use for manually selecting the social trails of interest, such as those around a lake or at a climbing location)

1. Zoom in or out within the map document so that you can see the entire area where the social trails of interest are located but close enough that you can distinguish each individual line or point.

2. Click on the “Select Features” tool – this is a white arrow next to a white and blue box.

3. Use your mouse to draw a box with the Select Features tool around the area that contains the social trails of interest. The selected social trails will be highlighted. If any were missed when drawing, you can redraw the box.

4. Once you are happy with your selection, right click on the shapefile that contains the selected social trails and choose “Create Layer from Selected Features.” This will create a new layer in ArcMap.
(5) You can save and export this layer by right clicking on this new layer → Export and using the Export dialog box to save the layer as a shapefile. You will likely need to do this once for the social trails and once for the social trail spurs, since they will be in different shapefiles.

(6) Add this new shapefile to the map document by going to “File” → “Add Data” → “Add Data.” Navigate to the folder where you saved the shapefile.

This link provides more guidance on how to select features interactively.

c. Data Analysis in GIS Environment

Calculating Length of Social Trails:

Data collected with mapping-grade GPS units or smart phones/tablet applications will already contain the length of the social trails in the attribute table (remember that social trail spurs have no length associated with them, as they are mapped as points). However, the length will be in meters and you may wish to recalculate the length to feet or other units. Data collected with the recreation-grade GPS units will not have the length automatically calculated. To calculate length or to calculate length in a new unit (feet or miles):

(1) Right-click on the shapefile containing the social trails for which you want to calculate length and select “Open Attribute Table.” Remember you should only be using the shapefile that contains social trails within the wilderness boundary (see “Splitting Social Trails to just Social Trails within Wilderness Boundaries” above for more information), or whatever subset of trails you wish to include. (Be sure you have completed the “Selecting a Subset of Social Trails or Social Trail Spurs for Analysis” section first.) For this procedure, right-click the shapefile that contains whichever subset of social trails is of interest.

(2) Add an empty field (basically a new column) where you will calculate trail length. Click the arrow next to the “Table Options” icon → “Add Field.” Name the field Length_Units (specify the units you chose) and choose “Long Integer.”

(3) Now you should have an empty field at the furthest right side of the attribute table. To calculate trail length in this field, right-click on the heading of that field → “Calculate Geometry.” Select “Length” in the first box, leave the coordinate system as is, and then select the measurement units you would like to use (feet is used in the example report provided). Click “OK.”

(4) Now you will have a new field at the end of your attribute table that is populated with the length (in your chosen units) for each social trail in the shapefile. The length in this column will be for each individual trail segment. If a single continuous social trail was mapped as multiple segments during data collection (e.g., because condition class changed), you may need to add together lengths of trail segments in Excel to compute the total length of the overall trail.

Here is a link to a help page about calculating geometry if there are problems or concerns.
Displaying Social Trails by Impact Characteristics:

As a good visual way to examine both the extent of social trails and the level of impact, you can create a map that displays the trails and spurs by condition class or other impact characteristics of interest. To do this:

1. Access the “Symbology” tab for your shapefile by right-clicking on the shapefile of interest → “Properties” → Click on the “Symbology” tab in the dialog box that opens up (Figure 8).

2. Within this tab select the “category” symbology (found on the column on the left side of the dialog box). Set the “Value Field” to the field that contains the condition class (or whatever impact characteristic you would like to display on the map). Now you can begin changing the symbology to represent the different condition classes.

3. At the bottom of the dialog box click “Add All Values.” All of the condition class categories should show up in the window now.

4. From here, it’s possible to change the symbols and colors of the social trails using the “Color Ramp” and double clicking on the symbol in the inset dialog box in the Symbology tab. This help page explains more about symbolizing in ArcMap.

**Figure 8.** Screenshot of symbology tab displaying social trails by condition class.
Calculate Density of Social Trails:

The “Line Density” tool in ArcMap (or the “Point Density” tool for social trail spurs) can be used to identify areas of high densities of social trails and social trail impacts. This may help prioritize management attention to certain locations.

**Note:** For the line density tool, all trails that are used in the density calculation need to be in a single shapefile. So you may need to merge shapefiles using the “Merge” tool if you have the social trails for a single area in multiple shapefiles. If you want to use a subset of trails or a specific region, use the selection process to “Create Layer from Selected Features” to make a subset of trails for the analysis (see “Selecting a Subset of Social Trails or Social Trail Spurs for Analysis”).

(1) Open the Search box in ArcMap and search for “Line Density.” Then select “Line Density (Spatial Analyst)” to open the Line Density tool.

(2) Select the shapefile to be used for the density calculation from the drop-down menu.

(3) Set the parameters for the density calculation. For population field select “None.” In the output raster box specify the save location for the raster output file. For cell output select a cellsize between 10 and 20. The cell size (or grid cell) specifies how big the “pixels” will be in the output raster file and can help with the resolution of the raster layer (see Figure 9).

(4) Some judgment will be needed to set the search radius. The search radius determines the distance around an individual raster cell that is used for calculating the density of social trails around that cell (see Figure 9). The search radius can be set to whatever distance and unit seem most appropriate for the area. A good search radius to start with is 100 feet. Once all the boxes are filled in, click “OK.”

(5) The output from the Line Density tool will be a raster layer that is a square on the landscape – the raster will calculate out to the total extent of the shapefile you input for the density calculation. How the raster is displayed can be changed in the “Symbology” tab. Right click on the new density raster shapefile → “Properties” → “Symbology” tab.

(6) In the symbology tab there will be a button labeled “Classify” – click on “Classify” to open a new dialog box. Select 3 to 5 classes and select the classification method that makes the most sense (suggestions: Natural Breaks or Standard Deviation).

(7) To exclude areas on the map in the display that have no social trails, click on “Exclusions” in the “Classify” dialog box and enter “0.” This will make it so that only trail densities greater than 0 will be displayed on the map.
Figure 9. How line density is calculated in ArcMap in the “Line Density” tool – figure pulled from “ArcGIS for Desktop” website (http://desktop.arcgis.com/en/arcmap/10.3/tools/spatial-analyst-toolbox/how-line-density-works.htm)

Note: The units for this raster are lengths of trails/ search radius value and units that were chosen when you made the raster. Additionally, the condition class, trail width or instance of human waste field can be used in the “Population Field” box in the “Line Density” dialog box to weight the density by these impact characteristics.

This help page provides more information on the Line Density tool.

The Point Density tool can be used in the exact same procedure (using the same instructions except searching for “Point Density” in step 1) to calculate the density of social trail spurs.

d. Map Making

Once data processing and analysis are complete in ArcMap and the symbology is set in a way to display condition class, trail width, or instances of human waste, then maps can be created in the “Layout” view of ArcMap to include in a summary report. For examples of possible maps that can be generated, please reference the summary report created as part of the pilot study testing this monitoring protocol (Kooistra et al., 2016). There is great variability in how to make maps and map making styles. Certain agencies have style guidelines for making maps as well. Therefore, it is recommended that managers consult with GIS specialists for the map making and exporting process if they are unfamiliar with ArcMap themselves. Additionally, there are numerous tutorials and “how-to” videos online that can provide thorough guidance on map making in the Layout view of ArcMap, map design, and exporting maps as JPEGs or PDFs.
e. Data Analysis in Table Format

This section includes instructions for exporting attribute tables in ArcGIS so that you can summarize the length in Excel (calculate total length of trails, sum total trail length by condition class, etc.).

Exporting Attribute Tables from GIS Environment:

The social trail impact characteristic information (condition class, width category, and human waste) and the newly calculated length for social trails (vs. spurs) will be associated with the shapefiles in ArcMap. Although it is possible to calculate simple statistics and summarize data in ArcMap, exporting these tables into Excel can make analysis and summary of these impact characteristics much easier.

For data collected with recreation-grade GPS units and paper data collection, the impact characteristics will already be in a table format in Excel. However, you will still need to export the attribute table for the social trails shapefile from ArcMap after you have completed the steps to join and calculate trail lengths (see above for instructions), as this table will include the length of each social trail. For social trail spurs, which have no length that needs to be calculated in ArcMap, there is no need to export the attribute table, as you should already have all the necessary information in table format in the original Excel file. However, if you have created a subset of an area for analysis (e.g., just social trails and spurs around a lake), you will need to export the attribute table for that subset of spurs to summarize impact characteristics for just that subset by following the instructions below.

To export an attribute table:

(1) In the table of contents window, right click on the shapefile for which you want to export the attribute table → “Open Attribute Table.” See Figure 10.

(2) The attribute table should be opened. Within the attribute table window click on “Table Options” icon (looks like a small spreadsheet) → “Export.”

(3) This should open an Export dialog box. Make sure it says Export “All Records.” Choose to save the file in .txt format. Name the file appropriately, choose the proper location for saving the file and click “Save” → Click “OK”

(4) The .txt table must now be converted from text to a comma delimited file in Excel. To do this, open the .txt file, copy all of the text in the file and paste this text into a new Excel spreadsheet. If the text does not automatically sort itself into columns – you can use the “Text to Columns” tool in Excel.

Repeat these steps to export the attribute tables of all social trail and spur shapefiles for which you want to summarize the impact characteristics.
Now that all of the data are in Excel format (including lengths calculated in ArcMap), you can begin summarizing the social trail impact characteristics as demonstrated in the example summary report generated for the pilot study of this monitoring protocol (Kooistra et al., 2016). The Excel file can also be used to summarize total length by condition class by sorting and summarizing the Excel file columns by condition class or by using pivot tables. This protocol focuses on the spatial analysis and does not go into detail about analysis in Excel or how to use Excel. There are many online resources for using formulas in Excel; please make use of these resources if you are unfamiliar with Excel.

**It is important to note that for this protocol calculating means and standard deviations for lengths of social trails is not advised.** These values could be misleading since individual social trails may have been mapped in multiple segments due to changes in impact characteristics. Therefore it is recommended, and is demonstrated in the example report from the pilot study, that total lengths by category should be used as the main method to summarize the overall extent.
of social trails, condition class, and trail width (Kooistra et al., 2016). For the occurrences of human waste, the total number of occurrences within each human waste category should be reported, as presented in the example summary report from the pilot study.

**Summarizing Findings:**

An example summary report for the pilot study, with notes, is provided to demonstrate how findings from the social trails monitoring protocol can be summarized. Instructions for producing many of the maps and calculations shown in the report are explained above. See Table 2 to help you locate the analysis steps and the subsequent outputs in the report.

**Table 2.** Reference table for where to find ArcMap analysis instructions in this report and examples of the analysis output in the pilot study summary report (Kooistra et al., 2016).

<table>
<thead>
<tr>
<th>Analysis Type</th>
<th>ArcMap Instructions (in this report)</th>
<th>Example Output in Pilot Study Report* (Kooistra et al., 2016)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Splitting Data</td>
<td>Page 22 &amp; Figure 5</td>
<td>Page 21 &amp; Map 10</td>
</tr>
<tr>
<td>Selecting a Subset of Data</td>
<td>Page 26 &amp; Figure 7</td>
<td>Page 27 &amp; all Tenas Lakes Maps</td>
</tr>
<tr>
<td>Calculating Trail Length</td>
<td>Page 28</td>
<td>Tables 2 - 7</td>
</tr>
<tr>
<td>Display by Impact Characteristics</td>
<td>Page 29 &amp; Figure 8</td>
<td>Maps 3 – 9 &amp; Maps 15 - 19</td>
</tr>
<tr>
<td>Social Trail Density</td>
<td>Page 30 &amp; Figure 9</td>
<td>Page 33 &amp; Map 20</td>
</tr>
<tr>
<td>Excel Table Calculations</td>
<td>Page 19 &amp; Figure 3</td>
<td>Page 12</td>
</tr>
</tbody>
</table>

*This report contains a large collection of useful, example maps and tables. The table above directs the reader to just a few of these examples for illustrative purposes.

**See Appendix E for a list of FAQs related to implementing this protocol.**

**REFERENCES**

Appendix A. Glossary

Condition Class. An assessment of the overall condition of the social trail or spur, based on vegetation loss and mineral soil exposure/erosion. Does not take into account trail width, which is tracked separately.

Mineral Soil. Mineral soil is soil that contains no organic material. In forested environments, the when vegetation is lost, the soil that is exposed may be “organic” horizons, consisting of pulverized organic matter or duff. Mineral soil is beneath these organic soil horizons.

Social Trail. Non-system, informal, trails created by visitor use that were not installed and/or not maintained by managers; may also include decommissioned system trails that are still used by recreational visitors. Also called “user trails.”

Social Trail Spur. Segments of social trail that are less than 30 feet in length. Spurs are mapped as points, not linear features.

Trail Width. The average length of a trail or spur’s cross-section.

User Trail. See “social trail.”

Vegetation Loss. This protocol requires assessing the relative loss of vegetation within the trail compared to the surrounding area. Essentially, a determination is made about how much vegetation would have been present if not for trampling by people.
Appendix B: Condition Class Rating Examples (Two Photos for Each Condition Class)

Condition Class 1
Condition Class 1
Condition Class 2
Condition Class 3
Condition Class 3
**Appendix C: Summary of Social Trail Characteristics -- Field Guide**

**Can be printed on a small card to be taken into the field**

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Trail Width**           | 1. < 12 inches in width  
2. 12 - 24 inches in width  
3. > 24 inches in width |
| **Condition Class**       | 1. Slight vegetation loss, no soil damage, low ecological impact  
2. Significant vegetation loss, no soil damage, moderate ecological impact  
3. Complete loss of vegetation, soil damage, high level of ecological impact |
| (compare to adjacent      |                                                                             |
| unimpacted areas)        |                                                                             |
| **Presence of Human Waste**| 0. No human waste or toilet paper observed  
1. 1 instance of human waste or toilet paper observed  
2. 2-3 instance of human waste or toilet paper observed  
3. >3 instance of human waste or toilet paper observed |
Appendix D: Example Data Sheet for Paper Data Collection

Social Trail Monitoring Data Sheet

<table>
<thead>
<tr>
<th>Personnel:</th>
<th>Monitoring Location:</th>
<th>Date:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unique Trail ID</th>
<th>Trail Length*</th>
<th>Spur(^\ddagger) (Y/N)</th>
<th>Width Category</th>
<th>Condition Class Category</th>
<th>Human Waste Category</th>
<th>Primary Activity Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Not needed if the trail is mapped with a GPS unit or GPS App (e.g., Collect by ESRI)

\(^\ddagger\)Spurs are social trails that are < 30 feet in length
Appendix E. Frequently Asked Questions

- How much time will it take to monitor social trails?
  - The time required for monitoring could vary considerably depending on the size of a wilderness, the extent and distribution of social trails, personnel available, and whether or not personnel are performing other duties at the same time (e.g., visitor contacts and campsite cleanup). A smaller (<10,000 acres) wilderness with relatively low use may only take a couple of days for one or two people. Larger areas with higher visitor use could take several multi-day visits to complete monitoring. It is clear that having at least two people in the field significantly improves efficiency if at least one person can monitor social trails while others complete other duties.

- What is mineral soil?
  - Mineral soil has no organic component. Pulverized duff or leaf litter is not mineral soil. (See Appendix A – Glossary.)

- How do I know when mineral soil exposure is “significant”?
  - In areas with naturally no vegetation (e.g., sandy washes or cinder cones), user trails can be large and highly visible. However, in these environments, the trails may have little ecological impact. Mineral soil exposure is considered significant when it has impact on the biotic components of ecosystems, such as introducing sediment into water bodies. Therefore, a social trail in unvegetated areas might be evaluated as condition class 1, and the visible aspects of such trails would be captured with the width classification.

- How do I determine the “average” condition and width of a trail segment?
  - Visually examine the entire length of the segment or spur. For longer trails, this may require stopping every few meters to assess width, vegetation cover, and mineral soil exposure. Be sure your overall assessment is not biased by a few very impacted or lightly impacted parts of the trail.

- What do I do if a social trail “disappears” and then picks up again?
  - In some environments, a social trail may be quite evident (wide with significant vegetation loss) but then essentially disappear for a stretch (in a meadow, for instance). When this occurs, record a separate trail segment for each impacted area and do not record a trail if there is no visible evidence of impact (even if you know people are walking in that area). This protocol only monitors visibly impacted social trails/spurs.

- Where do I start monitoring a trail at the edge of a campsite?
  - Where there is a definite edge to the campsite (e.g., a notable change in vegetation cover, a topographic feature, or other boundary) begin recording at that edge. In cases where a major user trail bisects a campsite, continue recording the trail through the site. (Ask yourself, do people use this trail to access some attraction or feature, apart from camping?)

- How do I monitor vertical climbing routes?
  - Trails at the base of climbs are monitored like any other social trail or recreation site.
  - Rock faces are not monitored as social trails. If data are needed about the extent and condition of climbs, a different protocol will be needed.
- Should sections of abandoned system trails be included?
  - If abandoned system trails (or decommissioned roads) are continuing to receive recreational use, they should be included as social trails.
  - If such trails/roads are not receiving use, it is up to the local unit to decide whether to monitor them. These decisions should be documented in analysis reports.

- How do I know if my device is collecting spatial data?
  - On the Collector App when recording a social trail, it will indicate “streaming” and, when recording a spur, the Lat/Long coordinates will appear at the top of the spur window. Also, the “Submit” button will be shaded if no data have been collected, and you will be unable to submit the GPS positional data.
  - On Juno devices, the unit will show the number of points or vertices being collected increasing and the feature will appear on your map.
  - Garmin GPS units do not provide real-time visual feedback; you will have to look at the record of the track by going into the “Track Manager” or the “Map” feature.

- How do I know if my data uploaded?
  - On the Collector App, no number (representing the number of features you have collected) will appear with the Sync Cloud symbol after you data has been successfully uploaded to the server.
  - On the Garmin GPS units, you will need to connect the Garmin device to a computer and use Garmin software to open the individual data that you have recorded. You will then manually export the data as GPX files. These files can be opened in software such as Google Earth to ensure data quality.
  - On the Juno devices, you will use S1 Data Manager which interfaces with ArcPad. Once you click the “Check In” button and the data have been successfully sent, a window will open to signify the check in is complete.

- Should I calculate the mean and standard deviation of the trail length?
  - No – some social trails may have been mapped in segments if the impact characteristics changed across the length of the social trail. Therefore the mean and standard deviation could be misleading and would only provide information about the mean of social trail segments not all individual social trails in an area.
  - For this protocol, it is recommended that you calculate total lengths, summarize the total length by the impact characteristics, and report frequencies of the impact characteristics categories (especially true for human waste occurrences). See Kooistra et al. (2016) for examples.

- Can I change this protocol?
  - This protocol includes the minimum elements necessary to inventory and assess social trails. However, it is entirely appropriate, and sometimes recommended, that local units add additional fields, such as activity type. This type of information can be included within the "comments" field, or can be added as entirely new fields.